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TG Version and this Tutorial

TG Introduction

TG2.4.20
The most recent version of Test Generator is TG2.4.20.  There have been several releases under this 
version.  A release is a newer copy of TG.  Releases are introduced for a variety of reasons: new 
features, or enhancements, bug fixes, as well as modifications to either TG, Tester or TG Options such 
as SecureTG.

Web Tester
Any TG Web customer who would like to update to the latest release will also have to update their 
web Tester.  These updates are free to customers who have an active support subscription.  Please 
contact us for more details.

Screens
Most of the screen shots in this tutorial are found in earlier versions of TG; however, the ability to 
view, copy and assign URL media links from the Media window, can only be experienced by updating 
to the latest TG2.4.20 release.  Please contact us to request an upgrade or update.

http://www.testshop.com/


This tutorial is intended for customers who:
• Would like to review this topic in more detail, or 
• May not have yet had an opportunity to participate in an online training sessions or
• Would like to “brush up” on the topic or
• Purchased an earlier version of TG that did not include some of the new media options

It’s also intended for those of you who are considering the purchase of Test Generator.
If you haven’t yet scheduled an online demo, we encourage you to do so.  You can schedule an 
online demo or contact us.

In order to perform the steps outlined in this tutorial…
• You have successfully downloaded the TG installation file from our web page. 

You have successfully installed TG on your computer.
• You can login to TG and view the home page.

About This Tutorial

Background / Assumptions

TG Introduction

http://www.testshop.com/schedule-demo
http://www.testshop.com/contact
http://www.testshop.com/


Test Creation and Media

TG Introduction

Test Generator enables test authors to use various types of media during the creation of questions.

Questions can be created within a TG question bank manually, or by importing them using any of 
the file types supported in TG: .csv, .txt, .xls, .rtf, .xml.

When we refer to “media” we mean everything from static images, documents, audio and video 
files to flash.  Here are some of the media types TG supports:

• Graphics: gif, jpg, png, bmp
• Audio: .wav, .mid, .mp3
• Text: .txt
• Adobe Acrobat: .pdf
• Flash: .swf
• Video: .avi, .mpg, .mov

Assumptions
• You are familiar with some/all of the media formats described above
• You have access to one or more media software tools
• You know how to create and edit your media assets or have access to a resource person

who is familiar with the file types and methods described in this tutorial.

http://www.testshop.com/


Methods for Assigning Media to a Question

TG Introduction

Option 1
Pre-TG2.4.15, we had indicated that it was possible (in TG LAN_sql and TG Web) to cut-and-paste 
static/still images into the question and answer fields.  This approach creates a "blob" in the 
database every time the media is pasted into a question or answer field.  

Example: If a test author were to cut-and-paste a GIF image into each of four answer fields, the net 
effect would be to add four "blobs" to the TG-sql database.  If this practice were repeated across 
multiple tests, it could produce a very large database and could lead to latency and performance 
issues.  We strongly recommend against using this option.

Option 2
Using an version of TG2.4.#, the test author can import media assets into TG's Media bank and then 
assign the media to a question.  Using this approach, one piece of media can be associated with 
multiple questions within the same test.

A media asset can also be assigned to different questions--in different tests.  Importing and 
organizing your media in the Media Bank also saves hard-drive space and keeps your database 
administrator happy. 

http://www.testshop.com/


Methods for Assigning Media to a Question

TG Introduction

Option 3
Beginning with TG2.4.15, test authors were able to embed a static image in the 
question or answer field by defining its path in TG's Media bank.  This option 
works in TG Web, with its web Tester, but not does not apply to TG Desktop or TG 
LAN, both of which use the windows Tester.

Format: tg://media/<media bank directory name>/<filename.***
Example: tg://media/equations/formula1.gif.

Option 4
Beginning with TG2.4.16: Creating an iframe in a question or answer field
Test authors can place links to external data/media sources in the question and/or 
answer fields.  This will place an iframe within the web Tester.  

Format: "ext://<n pixels wide>x<n pixels high>@http://<address>“
Example: ext://800x600@https://en.wikipedia.org/wiki/Main_Page

http://www.testshop.com/


Methods for Assigning Media to a Question

TG Introduction

Option 4
Beginning with TG2.4.20, we have introduced URL tags.  As a result of this enhancement, the URL is 
now accessible when viewing the media file within the Media Bank, or when selecting media during 
test editing.  If you are just getting started, we invite you to contact us for a free consultation.

http://www.testshop.com/


TG Products and Media Storage

TG Introduction

Where your media is stored will vary based on the TG product you purchased.

• TG Web media can be stored in TG Web's sql database, on your intranet or over the Internet.

• TG LAN_sql stores media in the sql database.

• TG LAN_msa stores media in a directory on the server.

• TG Desktop stores media in a directory on the desktop pc where TG was installed.

Best Practice

If you have, or are considering using, large video files we recommend storing these assets on a 

server/servers that are configured to process and stream these files.  Importing very large video 

files into the sql database is not recommended.

http://www.testshop.com/


Media Use in TG Desktop and TG LAN

TG Best Practices

If you use media in TG Desktop/LAN, we 
recommend importing your media into TG’s Media 
bank (a.k.a., folders, directories).  Start by creating 
one or more banks.  Media banks can be organized 
by media type, user, subject or any classification 
system you wish to use. 

Once your TG media banks are created, locate and organize the media on your computer so as 
to simplify locating the media content that you’d like to import into TG’s Media bank.  

One ready-made option are the various media directories (e.g. My Pictures, My Video) located 
under your computer’s My Documents directory.  

If you have your media organized in other directories, or you choose to deal with your media 
organization differently, fine.  There are several third-party media organization software tools 
available.



Media Use in TG Web

TG Best Practices

If you are using TG LAN with a Sql database, you can import your media assets under TG’s Media 
banks and then assign media to individual questions as required.

Naming Conventions
We recommend keeping media folder and file names short.
Name your media files prior to importing them into the media banks.
File names do not have to be unique, but it’s helpful if you have multiple test admins.

A word of caution: once a file is named, imported into the Media Bank and associated with a test 
item, we recommend that you not change it.  If you rename a media file, any previous (media) test 
question references will fail because TG is looking for a file name that no longer exists.  

URLs
Addresses for any media file that is imported into TG’s Media Banks use this format: 
tg://media/<media bank directory name>/<filename.***
Example: tg://media/equations/formula_1.gif.



Media Use in TG Web

TG Best Practices

Using iframes
Embedding media sources using an iframe, use this format:
ext://<n pixels wide>x<n pixels high>@http://<address> 
Example: ext://640x480@http://www.loc.gov, will place an iframe 640 pixels wide x 480 pixels high. 
The width and height can be modified by the test author to accommodate other dimensions

Editing Media
We recommend editing your media prior to importing it into TG’s Media Bank module.
TG does not contain any media editing tools.

Media Dimensions and File Sizes
Consider your testing audience when planning your media use.
Screen size and resolution can either enhance or inhibit the display of your media.  What looks good 
on a newer desktop or laptop monitor may be difficult to manage when viewed on an older 
computer monitor.  See guidelines later in this tutorial.





The Media Bank is a module located on TG’s home page. 
It’s a repository for everything from ".jpg" to ".txt" files.  
These files can be imported and stored in folders 
organized under the Media Bank module. 

You can organize your media in one or multiple media 
folders by file type, subject or whatever category suits 
your requirements.  In the following examples we are 
using generic labels, “mb1, 2 and so on” for the root 
media banks.  

Imported media can be used with any of TG’s question 
types, enabling you to use the same media file with 
different questions in the same test, or with various 
tests located in the same, or different, courses.

TG Media Banks

About TG’s Media Bank



TG Media Banks

How to Create a Media Bank
Open TG, Start > Programs > Test Generator. Click on the “G” icon.

1. Select the Media module.

2. R-click and select New Media Folder

3. Name the media folder.  Note: We suggest giving 
the media folder a name that will make it easy for 
you/your test authoring team to identify the 
subject matter.



TG Media Banks

How to Create Sub-folders
TG gives you the ability to create sub-directories under the parent bank. 

Highlight the media folder where you want to create a sub-folder.  Right-click on the folder, in our 
example the “mb2” folder.  A pop-up menu will appear, select the New Media Folder Under mb2
menu option which will then open a New Media Folder window. 

Keeping in mind the Naming Conventions that we 
described earlier in this tutorial, enter the name of 
the sub-folder and click OK.



TG Media Banks

How to Create Sub-folders
This process will create a new sub-folder under 
your root media bank.  

In our example, we’ve created a “Cardiology” sub-
folder under the root bank, “mb2”.

Repeat this process as many times as you wish.  

You can also create nested sub-folders 
to organize your data at various levels 
under the parent sub-bank. 



TG Media Banks

How to Import Media
Once you’ve created one or more media banks, you can begin 
importing your files.  

1- From  TG’s home page, select the media folder into which you 
would like to import your files, “Cardiology” in our example.

2- From TG’s text menu, select File > Import > Media.

3- This will open an Import Media window.  Navigate 
to wherever your media are stored by selecting the 
appropriate directory in the Look in: window.

In this example, we’ve organized our 
files under a directory we named  
media.  We recommend doing 
something similar in order to simplify 
locating and importing your files into 
the media banks you’ve created. 



TG Media Banks

How to Import Media
4- Select the media folder containing the media you would like to import.

5- Select the media file you wish to import into the folder you selected in step 1.  You can 
select more than one media file to import by Ctrl + clicking on additional files. 



TG Media Banks
How to Import Media
Next, click the Open button in the lower r-hand corner of the Import Media window.

6- This will import your media file and place it in the 
media folder you selected in step 1.  You can continue 
this process and add other media files to other media 
folders, or perform this process as needed. 



TG Media Banks
Editing Your Media Files
TG does not include a media editor for the creation, editing or processing of media files.

There are numerous media editing tools available in the marketplace, including 
Window’s Paint, which is included with Windows.  There are also more sophisticated 
media tools available for purchase.

If you need to edit/modify your media for use in a test, we recommend doing so before 
you import your media into TG.  If you discover that you need to edit the file you 
imported into TG, you can always delete the imported file (select the media in the 
media bank and click the delete button).  This process will not delete your original file.

Locate your original file and, using your media editing software, edit the original -- or 
make a copy and edit the copy – and then re-import it into the appropriate media bank 
following the steps outlined earlier.



TG Media Banks
How to View Your Media Files
From TG’s tree view, folders containing media have a “+” sign

Click the “+” sign to expand 
the folder and display its 
media contents.

Selecting a file will display the media on the right side of the screen.  If your media file 
dimensions are large, you may only see a portion of the image – even though the entire image 
was imported into TG. 

Note: If you open your test in TG and 
assign the media to a question, you 
will be able to view the entire image, 
as will your test taker once you 
complete and publish your test.



TG Best Practices

• If you have, or plan on having, multiple administrative-level users preparing 
tests that include media, we recommend establishing a TG media-use policy. 
This may help prevent the indiscriminate use of duplicate and/or extremely 
large media files, which may hamper a test’s performance.

• Currently, there are no file-size restrictions for imported media. Note: Large, 
uncompressed media files take longer to load and take up more space.  

• The display and behavior of media varies based on many factors, including 
network bandwidth and the processing speed and memory of your computers. 
Wherever possible, use compressed media files (e.g., JPG, GIF) instead of media 
formats (e.g., TIFF, BMP) that require more computer resources.

• Whether you assign media to your questions at the question-banking stage, or 
“on-the-fly” when you are creating a test, we strongly recommend that you take 
the time to review the test—as a test taker—before publishing the test to your 
test-taking audience.



TG Best Practices

• If you are not familiar with the various techniques associated with media 
processing and optimization, we recommend you spend time exploring some of 
the many online and print resources that address this topic. If you require 24- or 
32-bit, high-resolution images, we assume you are factoring in server and 
network performance as well as processor speed and memory requirements. We 
recommend experimenting with various image types to determine what will 
work best for you. 

• If you…
. Are new to TG or
. Have not yet participated in an online training session or
. Have questions about Media Banks or other TG features and best practices…

We invite you to contact us for a free consultation session. 
Please contact us. 

http://www.testshop.com/contact/


TG Media Bank

This method enables test authors to assign media to a question by clicking the Edit Media 
button and then choosing a media asset from TG’s Media Bank. 

From the tree view on TG’s home screen, select and open your test.
Double-click on the test icon to open it, or select File > Open Test.

Method 1: Assigning Media to Questions

From the test’s summary screen, select the question 
you want to add media to, and dbl-click on the row…

… to display the question in edit mode. 



TG Media Bank

From the icon toolbar, click the Edit Media icon.

Method 1: Assigning Media to Questions

Prior to December 2015, this action would display the 
Media window: “No Media selected for this Question.”

In the latest release of version TG2.4.20, clicking the Edit 
Media button will display the Media bank window and 
media folders.



TG Media Bank

Method 1: Assigning Media to Questions
Click on/open the media bank containing the image 
you want to use.

The entire Media window displays the 
media bank tree on the left, media 
description in the middle and the 
image on the right. 

In the bottom right-hand of the 
screen, select the Use Media 
button.



TG Media Bank

Method 1: Assigning Media to Questions
Here’s another example of media in a Media 
window.  This is what the test taker will see 
when they click on the Media icon during a 
test session.  The size of the display will vary 
based on the size and dimensions of the 
media used.

During the test editing process, you can 
open/close the media window by clicking 
the Edit Media icon.

In our map2 example, the media is now associated with the question we  selected.  Note: this 
method does not embed the image in the question or answer fields.  The media chosen for this 
question can be re-used with other questions in the same test or other questions in other 
tests, scattered across one or multiple classes. 

As a best practice, we recommend making this type of media assignment during the creation 
and editing of items at the question banking stage.



TG Media Bank

Beginning with TG2.4.20, we 
introduced adding media from TG’s 
Media Banks using a URL.  The URL is 
accessible under TG’s tree view by 
selecting  the file that you wish to 
use (1).  Once selected, details 
regarding the media file are 
displayed on the right side of the 
screen.  Note the TG Web URL (2).

Method 2: Media Bank URLs

You can then select the text in the URL field and 
copy the URL path using the Ctrl +  C keyboard 
shortcut or by r-clicking the highlighted URL and 
clicking the Copy pop-up menu option. 

Best Practice.  If you plan on using various media files in your test, we suggest creating a text 
file listing the media file’s description, file type and URL.  If you’re just getting started with the 
creation and organization of your Media Banks, we’d be happy to review the various options 
with you.



TG Media Bank

This method is designed  those of you who prefer to make your media choices “on the fly”, 
during test creation and is based on the following assumptions: 

a- You have created a new test, and 
b- Imported questions into your test—manually or using TG’s Test Wizard, 
c- The imported questions do not contain media and, 
d- You have edited the questions in the question bank prior to importing them into your test 
e- You have saved your test and are now viewing the test’s summary screen:

Method 3: Embedding URL Links in Questions



TG Media Bank

Method 3: Embedding URL Links in Questions

The Media window includes a 
tree view on the left, and media 
assets organized into folders.  

In the example on the right, we’ve 
imported the media file, “QT Interval2” (1) 
into the Cardiology media folder.  On the 
right, under the Media box, note the TG 
Web URL address.

Next, double-click on the row containing the question you want to edit.  In the example below 
we have chosen a Short Answer question type, but we have not assigned a correct answer so 
that we can demonstrate how you can use media with this question type.

Next, click the Edit Media 
button to display the Media 
window.  



TG Media Bank

Method 3: Embedding URL Links in Questions

Next, close the Media window and paste the URL in the 
question text field.  In our example, we pasted the URL 
“tg://media/QRS/qt-interval2.gif” below the question stem 
and then clicked the Save icon. 

You can then select the text in the URL field and copy the address 
using the Ctrl +  C keyboard shortcut, or by r-clicking the highlighted 
URL and clicking the Copy pop-up menu option. 

… or by r-clicking the highlighted URL 
and clicking the Copy pop-up menu 
option. 

Next, locate the red “A” in the icon 
toolbar to add an answer field to our 
question… 

… and then type in the correct answer—which, in our example, is 
“4”.   As a best practice we recommend clicking the Save button 
at various intervals during editing.



TG Media Bank

Method 3: Embedding URL Links in Questions
To review the question your testing audience will 
see it in the web Tester, click the Tools menu > 
select Preview Question in TG Web. This will 
display a pop-up listing three options.  You can 
choose any of these three options which will 
then launch the web browser…

If the steps above were performed properly, 
you should be able to view the question and 
image (2) whose URL we added in the question 
field.  Below the image is the answer field (3) 
where the test taker would type their answer, 

Please note, that the feedback portion of the 
window (1) would not be present during an 
actual test unless you had selected that test 
property.



TG Media Bank

Test authors can modify the display behavior of the media during the test.
These controls are located at the bottom of the Media window. 

Automatically launch media after X seconds.
If selected, this option will display the media window without requiring the test taker to click the 
Media button during the test.

Limit the number of times media can be viewed to X times
If selected, this option will allow the test author to control the number of times the media, 
associated with a particular question, can be displayed.  

If these control options are not used, then the default media display (during a test-taking session) 
requires the test taker to select the Media button in order to display the media.

How to Control the Media Display and Frequency



TG Media Bank

You can also refer/link to other media sources by placing a URL (web address) in the question 
field and/or answer fields.  This is helpful if you have already organized various media resources 
on the web.

For example you might instruct the test taker to click on a web address displayed in the question 
field (ex. http://www.testshop.com).  The link might include anything from a single image to 
several pages of content.  This is yet another option for accessing and displaying information 
during a test-taking session. 

When your test takers view the question in either the windows or web Tester, they can click on 
the link in order to display the appropriate information in a separate TG Browser window.

How to Access/Link to Other Media Resources 



TG Media Bank

TG enables test authors to provide feedback during, or at the conclusion of, a test.  One of the 
options includes the use of media as feedback. Also, see TG Help > Index > Feedback > 
Options. 

1- From the tree view on TG’s home screen, select and open your test.
Double-click on the test icon to open it, or select File > Open Test.

2- From the test’s summary screen, select the question you want to add feedback to, and dbl-
click on the row to display the question in edit  mode.

3- Select the Feedback tab and then click on the fb link in the row immediately above and to 
the left of the feedback tab.

How to Display Media Using the Feedback Option



TG Media Bank

4- This will display the Question Feedback window including a list of the available text, media 
and URL options and, by default, a text window.

Selecting either the media or URL options displays different content.

In our example, we’ve selected the Show Media Chosen Below option.
The display is similar to the edit media options described earlier in this tutorial.  If you click 
the OK button, the selected media will be displayed as feedback to the test taker either 
during, or at the completion of, the test – depending the test parameters you define.

How to Display Media Using the Feedback Option



TG Media Banks

Conclusion
We hope that this tutorial has proven helpful and provided you with a good 
foundation regarding the various methods for implementing media with your 
Test Generator tests.

If you have questions regarding this tutorial, or if you have special media 
requirements, please contact us.  We also offer customization services and we’d 
be happy to see if we can accommodate your requirements.

We are committed to the continuous improvement or our Test Generator 
products and we welcome your comments and suggestions

Thank You.

http://www.testshop.com/contact/




TG Glossary

Definitions
Test taker (t.taker). The test-taking audience: a.k.a., employees, trainees, students or 
customers. T.takers designations can be changed under TG’s home page: System > Settings > 
Designations tab.

Test administrator (t.admin). The test administrator or test author—the person responsible 
for creating or managing courses and tests.  This may include individuals in HR/Training as 
well as IT personnel.

Tester. Refers to the software used to deliver a test.  In TG Desktop and TG LAN, this is a 
Windows-based client that is installed on machines used by your test-taking audience.  In TG 
Web, it refers to the web Tester which is accessed through a web browser.  T.takers can log 
in to take a test using either a Mac or Windows computer.  TG’s web Tester supports 
Chrome, Firefox and IE on a Windows machine and Safari on a Mac.

Computer. TG’s admin client is a Windows application and t.admins must use a computer 
that has the Windows operating system installed on it.  The TG admin client can also be 
installed on a Macintosh computer using either Parallels or Boot Camp and the Windows OS 
installed.  For more information, open a web browser and search “using windows on a mac”.

http://www.testshop.com/Portals/95240/tutorials/about_web-tester_r1.0.pdf


TG Glossary

Definitions

Course or Class.  These terms are used interchangeably and refer to the TG folder/directory 
under which tests are saved.  A course that contains active tests and enrolled/eligible 
t.takers, is also referred to as a production course. 

System.  In TG, a module located under TG’s tree view.  It contains various system 
parameters useful in managing the TG testing system.

Server.  A centralized computer that manages access to information and resources on a 
network.  In TG LAN the testing database is stored on a server.  In TG Web, the web Tester 
and TG database are installed on a server. 

Test Properties.  In TG, a menu option accessible to t.admins during test creation/editing.  
This module contains various test parameters that can be applied to a test.  

TG Admin Client.  The Test Generator application used by t.admins.



TG Glossary

Definitions
Tree View.  TG’s Home page includes a column on the left side of the screen beginning with 
a user icon and name of the t.admin who has logged in to TG.  This column also contains the 
modules that t.admins use to create and organize test items in question banks, create 
courses and tests saved under one or multiple courses, manage t.takers, generate reports 
and analyze test data through TG Reports. 

URL.  “… is the abbreviation of Uniform Resource Locator. URL is the global address of 
documents and other resources on the World Wide Web.” –www.webopedia.com

As it applies to media in TG Web, the URL describes the address of media either within TG’s 
Media Bank, or media accessible within an organization’s Intranet or over the Internet.


	Test Generator�About Media
	Slide Number 2
	Slide Number 3
	Slide Number 4
	Slide Number 5
	Slide Number 6
	Slide Number 7
	Slide Number 8
	Slide Number 9
	Slide Number 10
	Slide Number 11
	Media Banks
	Slide Number 13
	Slide Number 14
	Slide Number 15
	Slide Number 16
	Slide Number 17
	Slide Number 18
	Slide Number 19
	Slide Number 20
	Slide Number 21
	Slide Number 22
	Slide Number 23
	Slide Number 24
	Slide Number 25
	Slide Number 26
	Slide Number 27
	Slide Number 28
	Slide Number 29
	Slide Number 30
	Slide Number 31
	Slide Number 32
	Slide Number 33
	Slide Number 34
	Slide Number 35
	Slide Number 36
	Slide Number 37
	Glossary
	Slide Number 39
	Slide Number 40
	Slide Number 41

